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1 General 

The datalogger family Txx is a new development, which stands out from the field due 

to its excellent price / performance ratio.  

The compact design and modular technology enables the datalogger to be used for a 

lot of various and different applications. The large display allows the measurement 

values to be read from a distance of several metres.  

Due to its extremely low energy consumption and large memory, the product is 

definitely appropriate for long term measurements in both mobile and stationary 

applications. 

The new-comers into the datalogger family are : 

 

 Datalogger THI  = temperature / humidity internal 

 Datalogger TSE = temperature / humidity external 

 Datalogger TCE = thermocouples      

 Datalogger TPR = temperature / air pressure 

  Datalogger THC = temperature / humdity compact (without display) 

  Datalogger TIC  = temperature / compact (without Display) 

 

The Datalogger THI is an electronic mini thermo-hygrograph with internal sensors. 

The Datalogger TSE has two channels, to which either two temperature sensors or 

one combined temperature/humidity sensor can be connected. 

The Datalogger TCE is a 2 channel datalogger for thermocouples(J,K,N,E,R,S,T).  

The Datalogger TPR enables the measurement of the air pressure as well as of the 

temperature. 

The Datalogger THC is a pricely affordable datalogger for temperature and humidity 

without display and the Datalogger TIC a single channel datalogger for temperature 

without display. 

 

 

 

 

 

  

  page 3 of 24  



Manual  Datalogger 

The SmartGraph 2 software, which is delivered along with the instrument, allows the 

user to visualize the data on the PC screen and to record them. 

The professional version SmartGraph 2 enables the values for temperature and dew-

point to be shown on the display optionally in °C or °F and the humidity in % (relative 

humidity) or in g/m³ (absolute humidity).      
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2 Display module 

 

The datalogger usually consists of two modules: the main body or display module 

and the module including the sensor(s)  

The memory, real time clock and the microprocessor controller are located in the 

display module. 

 

 
Alarm channel 1
Alarm channel 2 
 

s 
Special function
 
 

 

 

 

 

 

 

 

 

 

 

 

e 

 

Alternative display of date/time for the preselection or 

real time 

Format date: 12.10 

Format time: 12:10 

 

Figure: Datalogger Display Elements 

  

  
Unit for channel 1
Unit for channel 2
REC: recording “On“ 

STOP: recording “Off“
Display: preselection Mode: Activ
 Display: real time clock
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Explanations concerning the display operation: 

 

When a pre-set limit has been exceeded the alarm symbol of the corresponding 

channel flashes. Once an alarm has been recognized, the alarm symbol remains 

visible on screen in static form even if the limit is no longer exceeded. The alarm 

message can only be eliminated by selecting “Memory Readout” on the PC. 

 

If the Pre-selection mode (start flag) was selected, the start-date and start-time for 

data recording are shown on the Date/Time display. Once the pre-set date/time has 

been reached the start flag is eliminated, the real time clock display becomes active 

and data recording begins. 
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3 Module with internal sensors 

 

The sensors for temperature and relative humidity, the corresponding sensor 

adapters, and the serial interface (RS232) are located on this module. 

 

 
 

Figure: Module with internal sensors 

 

Necessary calibration intervals depend on the environmental conditions and the 

requirements of the permissible tolerance deviations.  

A single point calibration of the internal sensors can be carried out using a 

comparison standard. The captured offset values can be entered in the SmartGraph  

software under: Instrument / Configuration Of Instruments / Sensors / Settings. 

Two point calibrations can only be carried out in the factory. 
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4 Datalogger TSE with external sensors 

 

The connectors for the external sensors, the corresponding sensor adapters and the 

serial interface (RS232) are located on this module. 

 

 
Figure: module with external sensors 

 

 

Either one or two temperature sensors or one to two combined temperature/humidity 

sensors can be connected. (Two sensors are only to be used in combination with the 

Professional version SmartGraph 2).  If only one external sensor is used, it will be 

connected to the left hand sensor socket.  

 

Important: the datalogger is a mere two channel datalogger. By connecting a 

combined temp./hum. sensor both channels are occupied and further sensors 

will be ignored. 
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In order that the instrument may correctly recognise to which channels the sensors 

are connected, both sensor socket positions must first be free. If a sensor is 

connected to one of the two sockets, the indication UPLG (Unplug) appears in the 

corresponding line (Line 1= left hand socket, Line 2= right hand socket). 

 

If both socket positions are free, the indication SENS appears in the upper line, and 

the first sensor can be connected to the left hand socket position. 

10 seconds are left yet (countdown on the display) to connect an optional second 

sensor to the right hand socket position.  

 

Important: As long as SENS is shown on the display, the datalogger will not 

respond on the serial interface. It is therefore not possible to read out data or 

change the configuration. 
 

The extension cable can be used with both external sensors. 

Important: a maximum of 3 extensions can be connected to one 

temperature/humidity sensor and a maximum of 4 extensions to one temperature 

sensor.  
Extensions can affect the accuracy! 

 

Necessary calibration intervals are dependent on the environmental conditions and 

the requirements of the permissible tolerance deviations.  

A single point calibration of the sensors can be carried out using a comparison 

standard. The captured Offset values can be entered in the SmartGraph  software 

under: Instrument / Configuration Of Instruments / Sensors / Settings. 

Two point calibrations can only be carried out in the factory. 
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5  Datalogger TCE with thermocouples 

 

The datalogger TCE supports the following thermocouple types (TC) : K, N, J, E, R, S 

and T at both outputs TC1 and TC2. 

 

 

21

 

 

 

 

Important: the same TC type

make sure that the rotary sw

type (see table below). 

 

The TC is set up via a rotary s

up value appears on the left si

S0...S9). 

 

 

 

 

 

 

 

 

 

TC
 has to b

itch is s

witch on 

de at the
TC
e used for both outputs (TC1 and TC2) ; 

et in the position corresponding to the TC 

the plug-in side of the sensor module. The set 

 bottom of the display (switch position: 

 

 
Rotary switch to set up TC
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The sensor module should be removed to set up the TC (see § Changing the 

module). 

A maximum of 7 TC (type: K, J, N, E, R, S, T) can be selected via the rotary switch. 

A selection via the software is not possible. 

 

Table: correspondance rotary switch position and thermocouple type 

POSITION ROTARY SWITCH THERMOCOUPLE TYPE 

0 logger off 

1 K 

2 J 

3 N 

4 E 

5 R 

6 S 

7 T 

8 logger off 

9 logger off 

 

The channel which remains free (no connection with a TC) will show the cold junction 

temperature. 

The TC are connected via SMP connectors. 

 

Important: make sure to only use connectors with a blade ; stamped 

connectors are not allowed since they can irreversibly damage the TC 

connection plug. 
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Overview thermocouples  

Datalogger-TC 

 

Type- 
Code 

and ANSI colors 

Switch  
position 

Thermo- 
couple 

type 

Material 
of the connecting plug 

Measuring 
range 

°C 
   + –  

K 1 chromel/alumel chromel alumel -200 ... +1200 
T 7 copper-constantan copper constantan -270 ... +400 
J 2 iron-constantan iron constantan -200 ... +1200 
E 4 chromel-constantan chromel constantan -270 ... +1000 
R 5 Pt/13%platinum-rhodium copper alloy -50 ... +1770 
S 6 Pt/10%platinum-rdodium copper alloy -50 ... +1770 
N 3 nicrosil-nisil nicrosil nisil -200 ... +1200 

 

Important: check on the polarity when connecting a TC. 
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6 Datalogger TPR with temperature and air pressure  

 

There is no special instruction to follow concerning this model. 

The altitude of the place you are staying in can be set in the software SmartGraph2 

which is delivered along with the datalogger. You will then obtain an air pressure 

value based on the see level (1013,25 hPa). 

 

Table: referenced atmosphere 

Altitude/m Average air pressure/hPa 

0 1013,25 

100 1001,3 

200 989,5 

300 977,7 

400 966,1 

500 954,6 

600 943,2 

700 931,9 

800 920,8 

900 909,7 

1000 898,8 

1100 887,9 

1200 877,2 
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7 Datalogger TCI / THC (T°, T°/H without display) 

 

General: the hardware of the datalogger compact is almost identical to the hardware 

of the datalogger with display.  Two LEDs (a red and a green one) are used as a 

substitute for the display to indicate the operation mode and the alarm. 

In addition, you will find close to the serial interface a start / stop button to switch on / 

off the datalogger. 

 

 

  

 

 

 

 

 

 

 

Operation mode / Alarm
 e 

 

 

Serial interfac
n 
Start-/ Stop butto
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Start/Stop function: the off / on button enables the datalogger to start and  stop 

recording.  The manual activation / deactivation of the datalogger and the 

configuration in start/stop or in ring mode are independent..  By pressing the off / on 

button, the datalogger will start recording ; by pressing it again, the datalogger will 

stop etc.. 

 

Important: In the start / stop mode, the datalogger will start recording from the start 

date on (provided that this date is set in the datalogger) no matter if the start / stop 

button is being pressed during this time. 

Before the datalogger starts recording, it can be activated or deactivated too via the 

on / off button (s. timing diagram). 

 

 

 
Button: on 

Button: off 

 

 

Logger on 

Logger off 

 

 

LED green 

 

LED red 

 
Timing diagram: Datalogger THC/TIC in ring mode  
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Programmed start date 

(Button has no influence) 
 

 
Button: on 

Button: off 

 

 

Logger on 

Logger off 

 

 

LED green 

 

LED red 

 
Timing diagram: Datalogger THC/TIC in start/stop-mode  

 

 

 

The button should be kept pressed for approx. 1 sec. to start / stop the datalogger. 

When activating the datalogger, the green LED remains on during 3 sec. The red 

LED  remains on during 3 sec. when deactivating the datalogger. 

While recording, both LEDs on the datalogger or just one of them will flash at 10 sec 

interval.  This time interval is completely independent of the recording and storage 

intervals set by the user in the datalogger. 
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Alarm function: the datalogger is equipped with an alarm function on both channels 

(temperature and humidity) which enables the user to set minimum as well as 

maximum limit values.  

The red LED will flash in case of an alarm. 

If an alarm occurs while the datalogger is recording, the green LED will switch off and 

the red LED will start flashing. 

As soon as the measured values have become normal again, both LEDs will flash to 

signal that an alarm came up. This can be reset by reading out the memory. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Alarm limit 

 Readout of data memory 

LED red 

LED green 

Measuring value 

Timing diagram: Datalogger THC/TIC alarm 
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8 Changing the sensor module 

 

To change the sensor module, carefully remove the datalogger back-plate with a 

screwdriver. The sensor module can now be separated from the main body. 

Place the new sensor module on the guide rail of the main body and assemble the 

two modules by pushing them together until they embed. 

Important: The module must be connected only when the instrument displays 

"FAIL".  

 

 
Figure: removing the back plate 

 

 
Figure: assembly of the modules 
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9  Changing the battery 

 

If the temperature value in the upper display line is displaced by the word bAtt, the 

battery has to be changed. 

In order to do this, first remove the sensor module (see above “changing the sensor 

module”).  

Then remove the four screws on the rear of the display module with a suitable 

screwdriver. 

 

 
Figure: Opening the datalogger to change the battery 

 

Lay the display module on a flat surface, with the display facing upwards, and 

carefully remove the upper part of the plastic cover.   

Now remove the old battery and insert the new battery (Type: LS14500/Saft, 3.6V) 

into the holder. 

 

Important: Use battery type LS14500/Saft exclusively. Batteries other than this 

type are not permitted and can disturb the correct functioning of the 

instrument. Observe the correct polarity of the battery and read the safety tips 

on the battery. Please do not touch the battery contacts (grease on your skin 

may cause oxidation!). 
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The BAT indication now disappears and the measurement values are shown again 

on the display.  

 

Please check the time and adjust these if necessary again. 

 

The battery should be changed annually. Frequent data transfer with the PC reduces 

battery lifespan. 

 

 

 
Figure: changing the battery
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10 Mounting the Datalogger 

 

The datalogger can be used either as mobile or stationary data acquisition system. 

For stationary applications the datalogger may only be mounted on a flat surface. 

In order to do this, first remove the sensor module (see above “changing the sensor 

module”).  

Two holes for wall mounting are provided in the guide rail of the main body. Use 

these to mount the main body. Then carefully join the two modules together until they 

embed. 

 

 
Figure: mounting the datalogger 

 

An anti-theft device made from aluminium is now available alternatively to the 

mounting system. This device additionally enables datalogger to be dismantled and 

the data to be downloaded much easier.  
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From 2003 on all datalogger will be delivered with an additional wall mounting 

bracket which can be used optionally. For mounting it on an datalogger with display 

unscrew the lower screws from the housing and fix the mounting bracket with the 

additional longer screws (see fig.) 

 

 

 

t 

Fig.: Mounting the bracket 

 

Now fix the angle to the wall and push the datal

 

  
Fig.: Hanging in the datalogger on the angle 

  

  
Mounting the bracke
ogger over it with the bracket. 
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For the datalogger without display only the angle has to be fixed to the wall and the 

datalogger be pushed over it. 

 

 
Fig.: Mounting of a datalogger without display 
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Tips and Tricks 

 

• The battery should be changed annually (Type: LS14500/Saft, 3.6V). 

• Frequent communication with the PC reduces battery lifespan. 

• For the data transfer to the PC, only use the cable supplied. 

• Please avoid condensation on the datalogger and its sensors. 

• Recommendations for measuring interval: 1 minute; storage interval 10 

minutes 

Measuring rates < 1 minute will cause higher energy consumption an thus 

reduce battery life considerably. 
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1 Introduction to SmartGraph 
 

1.1 Manage, Configure 
 
SmartGraph enables the flexible management of several data logger devices by means of identifiers. 
Devices can be added at any time. A unique description can be assigned to every device.  
 
The measurement data is archived in files organized on a “calendar week” basis, stored in a separate 
folder (within the folder where SmartGraph was installed) for each device, named DlXXX, where XXX 
is a unique number assigned to each device. 
 
Access to the data stored for each device is provided via the name of the device. A device can be 
selected via the File Menu item “selected device” or via the device list box in the toolbar. 
 
For protection against data loss, e.g. because of a hard disk error, it is recommended to back up the 
data files (all DLXXX folders in the installation folder of SmartGraph) on a regular basis. 
 
See also: 2.4.2 configure devices 
 

1.2 The program interface 
 
The program interface provides display and management of the information and data for a device, in 
particular the measurement data.  
 
Measurement data can be viewed as diagrams or in a table. The program creates diagrams and tables 
for the selected device. Please see section 3.5.2 Auto Monitor for information on how to select the 
device/data to be displayed and how to configure/customize the display. 
 
In order to be able to present a large number of measurement channels and devices the interface is 
sub-divided where necessary into pages lying on top of each another. These pages are called monitor 
pages. Switching between different monitor pages takes place by selecting the label of the monitor 
page to be displayed from the label list on the lower frame. The list disappears if only one monitor 
page is in use.  
 
Basically, there are two different monitor page types:  
 

- Protocol Monitor:  displays log entries, depending on protocol settings (see 2.5.1 Protocol ).  
- Monitor pages for tables and diagrams 
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1.2.1 Diagrams 
 
Diagrams display the measurement data as curves on a date/time based x-axis. Up to 12 curves with 
measurement values from different sources, i.e. channels of a device can be displayed. 
 
In order to present measurement values in different units on a single diagram (like temperature and 
humidity), 2 Y-axes are used (left and right). The dots in the colors of the curves plotted beside the unit 
of the relevant Y-Axis show the mapping between curves and y-axis. 
 
Every channel of a device is always represented as 3 curves (for min/max/average values) – even if 
only one of these values is configured for the device. 
In order to display all channels of a device in a single diagram (if not more than 2 different units are 
reported by the device), the “maximum count of curves per diagram” settings in “options/auto-monitor” 
has to be set to 6 (for devices with 2 channels) or 12 (for devices with 4 channels). 
This way one can show e.g. the dewpoint (instead of humidity) and temperature curves of a 4 channel 
device in a single diagram. 
 
 
Navigation within the Date/Time Range 
These buttons in the toolbar control the selected Date/Time range (X-axis).  

 
 
You can move short or long distances forward or backward in time, or zoom in /zoom out the screen 
section along the X-axis. Zoom in/out can also be done by double-clicking with the mouse in the area 
of the diagrams. The mouse pointer appears as a magnifying glass here. Double-clicking with the left 
mouse button stretches the time range to the mouse position (zoom in), double-clicking with the right 
mouse button switches from the current time period to the next larger time range (zoom out).  
 
Context Menu 
For quick and easy changes to diagram contents and settings, a context menu is available.  

 
This menu pops up when the right mouse button is activated on the diagram. The same menu items 
are available under the Edit and View menus (under item Yt-Diagram), when a diagram is selected 
(the blue border around the diagram or table indicates the selected object).  
 
The following items can be selected here: 
Edit title, see 2.2.9.1 edit title 
Edit curve, see 2.2.9.3 edit curve 
Range of left/right Y-Axis, see 2.2.9.4 range of left/right Y-Axis 
Grid for left/right Y-Axis 
 
reference: 
If the reference for the diagram is not required this can be un-selected in order to provide more space 
for the diagram. 
 
Print Yt diagram 
Print diagram on one page. This can also be selected via menu "File -> Print -> Yt-diagram" or by 
clicking the print button .from the toolbar. 
 
The professional version of SmartGraph (see 1.7 Upgrade to Extended Functions ) supports extended 
printing functions like printing of up to 4 diagrams from a device on a single page, or printing 
all/selected diagrams from all/selected devices with a single command. 



 6

 



 7

 

1.2.2 Table 
 
The table displays the measurement values of one day. The time is presented in the right column. 
Measurement values that exceed the alarm limits are highlighted in bold and in red text.  
 
To preserve space on the display, the short description for the device and channel names are used to 
label the columns. 
The long description is shown in a pop-up help window when the mouse moves over the appropriate 
column label.  
 
Navigation within the Time Range: 
The vertical scroll bar is used to navigate within the data of the displayed day. The same can be done 
via the Cursor Keys (Cursor up, Cursor down, Page up, Page down) (See chapter 3.1 Keyboard 
Shortcuts). 
 
Navigation within the Date Range: 
The buttons  and  switch to the previous or next day. This can also be done via the key 
combination Ctrl Cursor Up or Ctrl Cursor Down.  
 
The time ranges of the tables and the diagrams are synchronized. The day presented in the Table is 
always within the time range selected for the diagrams.  
 
Context Menu: 
For quick and easy changes to the table contents and settings a context menu is available.  

 
 
This menu pops up when the right mouse button is pressed while the mouse cursor is above the table. 
The same menu items are also available via the menu item “table” of the Edit Menu and View Menu, if 
the table has been selected. 
 
The following settings can be changed here: 
Edit title: change the title of the table 
hide column: hide a column 
show column: show a column 
horizontal grid lines: show/hide horizontal grid 
vertical grid lines: show/hide vertical grid 
print table: The table is printed with the data of the selected day. This can also be done via the button 

 in the tools panel and via the menu item file -> print -> print table.   
 
See also: 
3.1 Keyboard  
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1.2.3 Auto Monitor 
 
Data for every device is displayed on one or more monitor pages (depending on the auto monitor 
settings for the device) within the “auto monitor”. 
 
 
Select the device: 
The device for which data is displayed can be selected in two ways: 

- select the device from the selection list in the toolbar 
- select the device from the menu item file - selected device 

 
The name and identifier of the selected device are displayed in the caption of the main window. 
 
Auto Monitor options: 
Diagrams and table for the selected device are displayed based on the options set for the auto monitor 
for this device. 
The settings can be viewed and changed selecting menu item options - auto monitor: 

 
 

- Maximum number of curves per diagram: With this the number of curves that are displayed in 
a single diagram can be limited. Valid values are between 1 and 10. If more channels than the 
maximum for one diagram are present in a data source, an additional diagram is displayed. 

 
- Maximum number of diagrams per monitor page: The number and units of the channels of a 

data source determine how many diagrams are necessary for presentation. If more diagrams 
are needed than the maximum number allowed per monitor page, additional monitor pages 
are displayed, and can be selected by the tab on the bottom of the window. 

 
- Use both axes in diagrams: When this option is activated, each diagram is provided with a left 

and right Y-axis if necessary, so that channels with data in two different units can be 
displayed. If the option is deactivated, only the left Y-axis is used. 

 
- Place table on separate monitor: When this option is activated, the table is displayed on a 

separate monitor page without diagrams. Otherwise diagrams and table are arranged together 
on one (the first) monitor page. 

 
- Use as default for new devices: when this option is selected, the values set for the current 

monitor will be used as default values for new devices that are added later to SmartGraph. 
 

- Apply to all devices: when this option is selected, the values set for the current monitor 
page/device will be applied to all configured devices. 
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After the settings have been changed, diagrams and table will be formatted for the selected device 
according to the new settings.  
 
The labels of the monitor pages are created from the device name and a serial number and cannot be 
changed by the user. 
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1.2.4  Monitor page for Tables and Diagrams 
 
The monitor page is divided into two parts (if a table is present on the page). On the left side up to 9 
diagrams are presented, on the right side a table. The border between the two sides can be moved 
using the mouse. The diagrams are arranged on the left side so that the space is filled as completely 
as possible. The arrangement of diagrams can be horizontal or vertical (see menu item View-
>Monitor).  
 
Selection: 
Whenever a diagram or table is selected, various menu items and buttons like the “Print” button, are 
related to the selected object. The selected object (diagram or table) is marked with a blue border. An 
object can be selected by clicking with the mouse on the object. The next object can be selected by 
using the tab key.  
 
Full Screen/Normal Screen: 
Each object (diagram or table) can be expanded to full screen size. The diagram or table then fills the 
entire monitor page. Switching to full screen and back to normal screen size can be done in 4 ways:  
 

- clicking on the button  or  on the upper right in the object. 
- Using the key combination <Ctrl> + and <Ctrl> -  
- Selecting the desired function from the monitor page context menu. 
- selecting the desired function from the menu item “Monitor” in the “Edit” menu.  

 
The menu items always relate to the selected object.  
 
hide/show object: 
Each object (table or diagram) can be hidden, i.e. it disappears from the screen, but is not lost and can 
be shown again. The remaining objects on the monitor page are re-arranged.  
 
Hiding an object can be done via: 
 

- the button  in the upper right corner of the object. 
- the context menu of the monitor page. 
- the menu item “Monitor” from the “Edit” menu. 

 
The menu items always relate to the selected object.  
 
Showing an object that has been hidden can be done via the context menu of the monitor page or the 
menu items in the “monitor” menu of the “Edit” menu. The object to be shown is selected form a list of 
hidden objects in a dialog box that pops up, and the position of the object in reference to the other 
visible objects can be specified.  
 
Note: The mechanism can be used to change the sequence of the objects on a monitor page by hiding 
an object and showing the object at a different position.  
 
Monitor page context menu:  
All functions that concern the monitor page are found on the context menu for the monitor page. This 
appears when the right mouse button is activated and the mouse is positioned over the tab panel of 
the Monitor or over the border between the diagrams and the table. The menu items also appear on 
the “edit -> monitor” menu (maximize/minimize object, hide/show object) or in the “view->monitor” 
menu (arrange diagrams horizontally/vertically)  
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1.3 Measurement device 
 

1.3.1 read data 
 
The content of the data logger/device that is connected to the PC via the serial interface is read and 
stored. This function can be started by selecting menu item “device -> read data” or by clicking the  
button on the toolbar. 
 
Requirement: The correct communication port must be configured.  
The communication port can be configured via menu item “device->communication”. 
 
Messages: 
The date and time from where data is to be read from the device memory can be specified here. 
Default is the date and time of the last read out of the device memory. With the "read complete 
memory" option all data stored in the device will be read. 
 
While the data is read from the device the message "transmission of data" is shown with an indication 
of the progress of the transmission (percentage reading). 
 
If the communication port has not been set up correctly, a message “interface already open” may be 
displayed indicating the configured interface is already in use, e.g. the mouse could be connected to 
that port, or a message “device does not respond” may be displayed if no device is attached to the 
configured port. Please check the configured communication port if such an error message is 
displayed. 
 

1.3.2 recorder 
With the recorder function measurement data from the attached device is read in intervals. Unlike the 
data read by “read data”, the data read via the recorder function is not obtained from the device 
memory, but the measured values are read directly. 
 
While the recorder is active, the connection to the attached device is permanently open. 
 
Note : using the recorder function reduces battery life ! 
 
The recorder is started or stopped via the menu item 'device - recorder - start/stop recorder' or via the 
corresponding button  in the toolbar. When recording is active, the recorder symbol is displayed in 
the status bar. 
 
In recording mode, the following menu items under menu “device” are disabled:  

- communication 
- read configuration 
- read data 
- clear memory 
- synchronize clock 

 
The device internal clock is synchronized to the PC clock during the recording process.  
 
The following actions stop the recording mode: 

- changing device or channel settings ("configure devices") 
- "delete device" 

 
The time interval for data collection in recording mode is determined from the device’s “sample 
interval” setting. 
 
If “auto scroll” is checked (menu device-> recorder or toolbar button   ) new data read from the 
device is displayed on the auto monitor page(s) for the device, and diagrams are scrolled to show the 
new data. 
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When the recorder function is active, the time range for neither the diagrams (curves) or nor the table 
can be changed, and the selected device cannot be changed either.  
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1.3.3 clear memory 
This function clears the memory of the attached device, i.e. the data stored in the device is deleted. 
 
 

1.3.4 read configuration 
The configuration of the connected device is read. 
 
If no corresponding auto monitor page for the attached device has yet been set up, it is created. 
SmartGraph offers to switch to the appropriate auto monitor page for the device. 
 
 

1.3.5 synchronize clock 
The clock of the connected device is synchronized to the PC clock.  
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1.4 Display and analyze data 
 
Measurement data can be displayed in diagrams covering time ranges from 10 seconds to 1 year. 
 
To navigate within the time range of the diagrams use the buttons on the navigation toolbar on the 

upper left under the main menu:  
 
 
The same functions are available via menu “edit”. Zoom in/out can also be done using mouse clicks. 
See also: 3.1 Keyboard   
 
zoom in, zoom out: 
As soon as you move the mouse pointer over a diagram it changes into a magnifying glass.  
 
To zoom in hold the magnifying glass over the required position and click twice with the left mouse 
button (double click) or click on the  button on the toolbar. The diagram now switches to the next 
smaller time range, with the clicked position centered on the diagram. 
 
To zoom out click twice with the right mouse button or click on the  button on the toolbar. 
 
The possible time ranges are:  
Year-Month-Week-Day-6Hours-1Hour-10Minutes-1Minute-10Seconds 
 
Scroll: 
 

 scroll small interval backward 
 

 scroll small interval forward 
 

 scroll large interval backward 
 

 scroll large interval forward 
 

 scroll to the end of the data 
 

 edit date / time range 
A dialog box to enter the date/time range to be used is displayed. The minimum time range is 10 
seconds, the maximum time range is 1 year. See 2.2.8 edit date / time range. 

 
 
The selected date/time range applies to all diagrams (and all devices). 



 15

 

1.5 Documentation 
 
Printing of tables and diagrams:  
The selected table or diagram can be printed via the context menu of the selected object, or the menu 
item file - print, or the print button  from the toolbar. 
 
(See chapters 2.1.2 print and 2.1.3 print setup). 
 
 

1.6 Organization of measurement data 
 
The measurement data for each device is kept in a different folder within the SmartGraph installation 
folder. 
The data folders are named “DLxxx”, where xxx is the unique number assigned to each device by 
SmartGraph. 
 
The measurement data is saved in files on a “calendar week” basis (i.e. one file per week) named 
"KWjjnn.sgr", where “jj” stands for the year and nn stands for the week number. 
 
When a device is deleted the subdirectory DLxxx for the data of this device is renamed to DLxxxBAK. 
The files are not deleted. If a device has been inadvertently deleted, the procedure can be reversed as 
follows: quit SmartGraph and rename the folder DLxxxBAK to the DLxxx (e.g. using the File Manager). 
The next time SmartGraph is started the data for the device will be displayed again. 
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1.7 Upgrade to Extended Functions 
 
 
In the professional edition of SmartGraph the following functions are available: 
 

- Beside the standard measurement units (e.g. temperature in °C and humidity in %RH) other 
units (e.g. temperature in °F or dew point temperature, etc.) can be assigned to the 
channels/sensors of a device. 

 
- Measurement data can be exported to text files (with several options for formatting). 

 
- Extended functions for printing of diagrams are available (e.g. print all diagrams of a device, 

print all/selected diagrams of all/selected devices, print up to 4 diagrams on a single page). 
 
Unlocking via key-code 
The upgrade to the professional version is done by aquiring a key code. 
 
To do this, select the menu item options -> upgrade -> order. Fill out the fields in the dialog box 
"offer/order for unlock code". Select print to print out the order form. Fax the order to the given fax 
number / your distributor and you will shortly receive the Key-Code for the requested version. 
 
If you are in agreement with the License conditions select the menu item options -> upgrade -> 
unlocking. Enter the key-code. The additional functions can now be used.  
 
If the number of managed devices does exceed the number matching the professional version you 
have orderer, the additional functions are deactivated. 
 

Test-Upgrade 

Upgrade to professional or pharma version for testing - limited to 4 weeks. 
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2 Menu Commands 
 

2.1 “file” menu 
 
The File menu contains the following items: 
 

2.1.1 device 
Select the device to be displayed on auto monitor 
 

2.1.2 print 
Print diagram or table 
 
The selected object (diagram or table) or a screenshot (complete visible monitor page) can be printed. 
 
In the professional version of Smartgraph extended printing functions (like printing all diagrams of a 
device or selected/all diagrams from selected/all devices) are available. 
 
Tip: the logo saved in the file LOGO.BMP in the folder “support” is printed in the right upper corner. If 
you replace this file you can use your own logo. 
 

2.1.3 print setup 
 
Select printer and configure printer options. 
 
With most printers you have the choice between various graphic resolutions. A higher resolution 
increases quality, however the time required for printing is longer. Try various resolutions to find the 
best solution.  
 
Tip: For printing diagrams on a single page "landscape" orientation is best suited, for printing tables 
“portrait” orientation may be suited better, depending on the number of columns. 
 

2.1.4 page setup 
 
Set up title and page borders 
 
The dialog box 'page setup' appears:  
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title, subtitle 
Title and subtitle will be printed on every page.  
 
Page margins 
Specify the margins (in cm) to be used (the paper size and page orientation is configured via print 
setup for the printer) 
 
Print lines dotted: 
If this option is checked, the diagram curves are printed dotted (as configured for the diagram - see 
2.2.9.3 Edit curve), if printing to a black and white printer. For color printers, this option does not take 
effect. 
 
Tip: A logo appears in the top right corner of every printed page. This logo is read from the file 
Logo.bmp, which is located in the folder “support”. This file can be replaced (or supplied) if a logo is 
required. If no logo is required the file can be renamed or deleted. 
 

2.1.5 exit  
Exit SmartGraph (end the program). 
 
 
 

2.2 “edit” menu 
 
The Edit menu contains the following items: 
  

2.2.1 large interval backward 
scroll selected time range one (displayed) time interval backward. 
 

2.2.2 short interval backward 
scroll selected time range one (next shorter) time interval backward. 
 

2.2.3 zoom in 
Use the next smaller time interval in diagrams (double click left mouse button over diagram). 
 
Possible time intervals are: Year-Month-Week-Day-6Hours-1Hour-10Minutes-1Minute-10Seconds. 
 

2.2.4 zoom out 
Use the next lager time interval in diagrams (double click right mouse button over diagram). 
 
Possible time intervals are: Year-Month-Week-Day-6Hours-1Hour-10Minutes-1Minute-10Seconds. 
 

2.2.5 short interval forward 
scroll selected time range one (next shorter) time interval forward. 
 

2.2.6 large interval forward 
scroll selected time range one (displayed) time interval forward. 
 

2.2.7 last record 
scroll to the end of the data (to last data record). 
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2.2.8 edit date / time range 
A dialog box to enter the date/time range to be used is displayed. The minimum time range is 10 
seconds, the maximum time range is 1 year. 

 
 
The other menu items depend on selected object: 
 
When a monitor page or object is selected, to which these functions are not applicable (e.g. Protocol 
monitor), these menu items do not appear or are deactivated. 
 

2.2.9 Yt diagram or table 
 
These menu items are also available in the context menu that pops up when the right mouse button is 
clicked over the surface of a diagram or table. 
 
The following settings can be specified here: 
 

2.2.9.1 edit title 
 
Whenever a table or diagram object is created, a standard title (consisting of the object name and a 
number) is assigned to the object. 
 
“edit title” opens a dialog box to enter a user defined title for the object. To use the user assigned title, 
the checkbox “special title” has to be marked. End the dialog with OK. An empty title is not allowed. 
 
The standard title can be reactivated by marking the “stanrad title” checkbox. 
 

2.2.9.2 hide/show column (for tables only) 
 
hide column: 
A dialog box appears in which the column to be hidden can be selected. The selected column is 
hidden, but not deleted, and can be made visible again using “show column”. 
  
show column: 
This menu item is only available if columns have been hidden. A dialog box appears in which the 
column to be shown can be selected. The position of the column can be specified.  
 
Note: The mechanism can be used to change the sequence of the columns in a table. 
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2.2.9.3 edit curve (for diagrams only) 
 
View/edit curve settings for selected diagram.  

 
 
The available curves are shown in a list on the left side of the dialog. The entry in the list that belongs 
to the current curve is highlighted, i.e. selected. To edit the settings of a specific curve select the curve 
from the list on the left. 
 
The parameters that can be set on the selected curve are shown on the right side of the dialog: 
 

- curve visible: If this setting is activated the curve appears in the diagram and in the reference, 
otherwise the curve is hidden. 

 
- alarm limits visible: If this option is checked the alarm limits of the selected curve (device 

channel) appear on the diagram in the color of this curve. This option is only available when 
the curve is visible. 

 
- color of curve: by clicking with the left mouse button a list with the 16 standard colors is 

displayed. A color for the curve can be selected by clicking on the corresponding entry. If a 
different color (not in the standard colors) is desired, clicking with the right mouse button on 
the selection element starts a color selection dialog. The curve and the corresponding 
reference entry are then shown in the selected color.  

 
buttons: 
 

- accept: with "accept" all changes specified since the start of the dialog, are saved. 
 

- cancel: the dialog is ended without saving the changes that were specified since the beginning 
of the dialog. 

 
- exit: the changes are saved (see “accept”) and the dialog is ended.  

 



 21

 
 

2.2.9.4 range of left/right Y-Axis (for diagrams only) 
 
The dialog enables setting of the value range for the Y-axis for a given diagram (vertical zoom). 
 
automatic: 
The automatic setting is selected by activating the relevant upper option field. The corresponding 
value is shown on the right. The value for maximum/minimum in automatic setting are taken from the 
sensor settings (see 2.4.2.2 Edit Channel ) - the automatic maximum/minumum value for the axis is 
the maximum/minimum “view range” configured for all channels associated to this axis. 
 
Manual: 
The manual setting is effective when the relevant lower option field is activated and the requested 
value is entered in the input field.  
 
Buttons: 

- OK: With "OK" all changes are saved. The dialog is closed.  
- Cancel: The dialog is closed without saving the changes. 

 

2.2.10 monitor 
 
This menu item is visible (as an item on the “edit” menu) if a monitor page for diagrams and tables is 
selected – or are displayed as part of the monior page context menu. 
 
maximize object 
The selected object is maximized to full screen size  
 
normal view of object 
The maximized object is returned to its normal size  
 
hide / show object 
The selected object is hidden, but not deleted. With 'show object' a dialog box with all hidden objects is 
displayed. 
 
 
 
When a monitor is in use, to which these functionss are not applicable (e.g. Protocol monitor), these 
menu items are not shown. 
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2.3 “view” menu 
 
The menu item View shows the appropriate sub menu items depending on the selected object: 

2.3.1 monitor 
 
This menu item is displayed when a monitor page for diagrams and tables is selected. 
 
Diagrams on the monitor page can be arranged horizontally or vertically by selecting  
 

- arrange diagrams horizontally 
or  

- arrange diagrams vertically 
 
 

2.3.2 Yt diagram 
This menu item appears if a diagram is selected. 
 
grid for left y-axis: 
Show or hide the grid lines for the left y-axis 
 
grid for right y-axis: 
Show or hide the grid lines for the right y-axis (only available if both axis are used on the selected 
diagram). 
 
reference: 
Show or hide the reference on the selected diagram. 
 
These menu items are also available in the context menu for the diagram, which pops up when the 
right mouse button is clicked over the surface of the diagram.  
 

2.3.3 table 
 
This menu item appears if a table is selected. 
 
horizontal grid lines: 
Show/hide horizontal grid lines. 
 
vertical grid lines: 
Show/hide vertical grid lines. 
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2.4 “device” menu 
 

2.4.1  communication 
The communication port (serial port) on which the device(s) are attached can be configured here. 
 
Mark the interface to which you wish to connect the device and close the dialog box with 'OK'.  
 
Note: 
If an error message 'Interface already open' is displayed when connecting to a device, make sure the 
proper serial port is configured and not used by another application. 
If an error message ‘device does not respond (Timeout)’ is displayed make sure the device is 
connected to the selected interface, and the proper cable (supplied with the device) is used. 
 

2.4.2 configure devices 
 
This command opens the dialog box “configure devices”: 

 
 

 
 
The device and channel configuration can be changed here. 
 
The available devices that can be configured are presented in a tree diagram in the left part of the 
dialog.  
The device (or channel) to be configured can be selected by clicking on the corresponding entry in the 
tree view.  
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By double-clicking a device entry the associated list of the subordinate elements (the channels for this 
device) can be expanded or hidden.   
The selected entry is highlighted.  
 
On the right side of the dialog the settings for the selected entry (device or channel) can be edited.  
 
For further information please refer to chapters:  

- edit device 
- edit channel 

 
 
Buttons: 

- OK: With "OK" all changes that were made since the beginning of the dialog are saved. The 
dialog is ended.  

- Cancel: The dialog is ended without the changes being saved. All changes made since the 
beginning of the dialog are discarded.  

- Print: the configuration data of the currently selected device is printed. A dialog to enter a 
comment is displayed. The comment will be shown on the printout. 
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2.4.2.1 edit device 
 
Following configuration items for a device can be viewed/edited:  
 
Information: 

- SmartGraph-Id: 
This identifies a device uniquely within the SmartGraph software. It correlates to the name of  
the folder where the data for this device is stored (e.g. DL005) 
The identifier can not be changed  

 
- designation: 

The designation of a device. Any name/description can be assigned. This name (and the 
assigned ID) is used in SmartGraph to identify the device.  

 
- short name: 

The short name for a device is used where showing the designation would use too much 
space. Therefore only a short string should be assigned here. 

 
- Further internal information from the device like hardware and software versions are 

displayed, but cannot be edited. 
 
logging mode: 
 
The logging mode parameters for the device can be configured here. 

- storing mode: In “start/stop” mode data logging (recording) stops when all available memory 
has been used to store data. In “circular” mode the recording is continuous, but if all available 
memory has been used, oldest data entries are overwritten with new values 

 
- sorting of: The following measurement values can be logged/recorded:  

o average: average measurement value over “storage interval” 
o maximum : maximum measurement value in “storage interval” 
o minimum : minimum measurement value in “storage interval” 

At least one value must be selected. 
 

- Sample interval : time difference between samples (times when measurement values are read 
from the sensor) 

- Storage interval : time interval for data logging 
 
 
preselection: 
When preselection is enabled data logging only occurs at the preselected time. The selected date/time 
must be set to a time in the future. 
 
Note for devices of the DL-series: preselection does work for devices of the DL-series in start/stop 
and ring mode. For the DL 100M the device must be switched to mode S3 or S4 in order to activate 
preselection. A flag symbol in the display of the devices indicates that preselection is enabled. A clock 
symbol in the display indicates that preselection was activated (i.e. data is recorded). Other devices of 
the DL-series, i.e. all two- and four-channel devices with and without display, need to be switched on 
in order for preselection to work! 
Attention: For the DL 100M the symbol for enabled preselection is displayed even if the device is in 
mode S1 or S2 – but in those modes no data is recorded by the device! 
 
 
sensors: 
The sensors attached to the two logger channels are displayed here.  
Settings: Using the buttons the edit dialog for the corresponding channel can be accessed (see edit 
channel). 
 
modify sensors (professional version only):  the measurement units in which the data for a device 
channel is stored can be changed here. The dialog box “modify sensors” appears. 
 
The (physical) unit in which the data for a device channel is stored and presented can be modified 
here. 
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Depending on the sensor circuit board installed in the device the following measurement units are 
available:  
Temperature in °C or °F, relative humidity in %RH, absolute humidity in g/m³, 
dew point in °C or °F 
 
Not all measurement unit configurations are possible. The following limitations apply:  

- With the internal sensor circuit board and the external circuit board with one probe the 
measurement units in the two channels must be different.  

- With the external sensor circuit board with two probes the measurement units in the two 
channels must originate from different probes.  

 
When the measurement unit for a channel for which data has already been stored by Smartgraph is 
changed, a new channel for the new unit is created.  
 
The old data stored with the old unit setting can still be viewed. The device appears in SmartGraph 
now with more than two channels. The channel with the old unit settings no longer corresponds to any 
physical device channel. Accordingly, some parameters for this now “virtual” channel cannot be 
modified 
 
 
For detailed instructions on the device settings please refer to the device manual.  
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2.4.2.2 edit channel 
 
The following parameters of a channel can be viewed/edited:  
 
information: 

- SmartGraph-ID: The SmartGraph Identifier for this device. Cannot be changed. 
- sensortype, sensor PCB, assigned device channel : additional information about the attached 

sensor, can not be modified. 
- offset : offset (calibration) for the attached sensor. 
- designation : descriptive name for the channel (up to 79 characters). Used to refer to this 

channel within SmartGraph 
- short name: short name for the channel (up to 20 characters). Used within SmartGraph where 

the descriptive name would be too long (use too much space). 
 
alarms: 

- alarm at: if set to “storing data”, alarms are triggered when data exceeding the given alarm 
limits is stored, if set to “sampling of data” alarms are triggered when data exceeding the given 
alarm limits is sampled. 

- alarm limits: maximum and minimum boundaries for the alarm. An alarm is triggered if the 
(stored or sampled) value is below the minimum or above the maximum value configured. 

- Alarm hyteresis: the hysteresis for the alarm. 
 
display: 

- decimal places : number of decimal digits used in data representation for this channel 
- view range in diagrams : the default range assigned to the y-axis of a curve in a diagram 

where data for this channel is displayed. (See 2.2.9.4 Range of left/right Y-Axis (for diagrams 
only)) 

 
 
 
 
 
Notes:  

- If (device or channel) parameters are modified that are stored in the device, clicking the 'OK' 
button will cause SmartGraph to connect to the device and transfer the configuration changes. 
The device needs to be connected to the configured serial port. 

- If the device or channel configuration has been changed outside this SmartGraph installation 
(e.g. with SmartGraph on a different PC, or through a firmware update or a change in the 
sensor hardware), the configuration needs to be read first (device -> read configuration) 
before changes can be applied. 
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2.4.3 delete device 
With this command a device can be deleted. After removal the device is not displayed in SmartGraph 
anymore. 
 
A selection box to select the device to be deleted is shown.  
 
Select the desired device from the list. 'OK' deletes the device, ‘Cancel’ aborts the action. 
 
If a device is deleted, the data stored for this device is not really removed from the hard disc, but the 
folder is renamed from DLxxx to DLxxxBAK. 
 
Instructions regarding recovery of the data can be found in chapter 1.6 Organization of measurement 
data. 
 

2.4.4 read configuration 
Read the device configuration. 
 
See also: 1.3.4 read configuration 
 

2.4.5 read data 
The data stored in the logger device is read and stored. 
 
See also: 1.3.1 read data 
 

2.4.6 clear memory 
delete the data stored in the device memory. 
 
See also: 1.3.3 clear memory 
 

2.4.7 synchronize clock 
The internal clock of the connected device is synchronized with the PC clock. 
 
See also: 1.3.5 synchronize clock 
 

2.4.6 recorder 
The recorder function reads data from the device “online” and displays this data. 
 
See also: 1.3.2 recorder 
 
 

2.5 Options Menu 
 

2.5.1 auto monitor 
Set auto monitor options. 
 
See also: 1.2.3 Auto Monitor 
 

2.5.2 protocol 
Set protocol options: 
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short protocol 
only errors are logged in the protocol. 
 
limit size of protocol file  
the maximum size of the protocol file is limited to the given size. If the size is exceeded the old file is 
renamed. The new file name consists of the date of the last entry.  
 
maximum size: 
The maximum size of the protocol file can be selected between 10 Kbytes and 9999 Kbytes. This 
setting is only available when the option “limit size of protocol file” is set. 
 
protocol only during Auto Mode: 
Messages are only written to the protocol file in Auto Modus. 
 
When the current protocol file contains messages, an additional monitor page “protocol” is displayed. 
 
Auto Mode is only active when the recorder is active. 
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2.5.3 export 
 
The “export” function is only available with the professional version of SmartGraph. 
 
Export data to a text file. Data from devices controlled by SmartGraph can be exported to a text file for 
further processing with other applications (e.g. for import in a database, word processing or 
spreadsheet application). The formatting of the text file can be customized.  
 
The function is available from the menu topic 'options -> export' or the corresponding button  on the 
toolbar. 
 
The export dialog consists of several steps: 
 
Step 1: time period for export 
Begin and end date/time for the data export is specified here. The end date/time must be at least 1 
second later then the begin date/time. If “export without date” is selected, the time column will not be 
part of the exported data rows (e.g. if data from one day only is exported). 
 
 
Step 2: channels to be exported 
The channels to be exported are specified here. 
Selected channels are shown in the list (device name and channel name). 
Channels to be exported can be selected by 

- clicking the button 'channels of selected device' : all channels of the selected device 
(displayed in AutoMonitor) will be added to the export 

- clicking the button “setup channels” : a dialog to select channels from all configured devices is 
displayed. See 2.5.5.1 setup channels 

 
Step 3: channel information to be exported 
In addition to the measurement data, information about the device(s) and channel(s) can be included 
in the export output file. This information will be included as “header” information in the export output. 
This header and the rows containing the measurement data are separated by the word 'data'.  
The following information is available and can be selected via the checkbox in the selection list. 

- channel no: serial number for the channels in the corresponding column 
- data source: long name (description) of the device 
- data source short: short name of the device 
- channel: long name (description) of the channel 
- channel short: short name of the channel 
- sensor type: identification code for the sensor type  
- unit: measurement unit 
- min: minimum value of sensor measurement range 
- max: maximum value of sensor measurement range 
- alarm min: lower alarm limit 
- alarm max: upper alarm limit 
- logger ID: unique (internal) identifier for data logger device 

 
Step 4: export to file 
The file name (including its path) can be changed in the input field or via a “file selection dialog, which 
is shown when the 'browse' button is clicked. If an existing file is selected, the option 'append to 
existing file' will append the new data records to an existing text file. In this case, channel information 
(header, step 3) is not exported. If the option is not active an existing file will be overwritten. If a new 
file name is selected, this option field does not apply.  
 
Step 5: Format settings  
The following settings can be customized: 

- date format: date separator, order, year (2 or 4 digits) 
- time format: separator character between hours and minutes 
- decimal seperator: (“.” or “,”) for measurement values 
- columns delimiter: delimiter between data columns (e.g. channels). May not be the same as 

the separator for date and time. 
- line end : character to separate lines (rows) (e.g. CR LF) 
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- Character string to be entered for erroneous or invalid/nonexistent measurement values e.g. "-
--" or "MISSING". The character string must not contain the column separator. An empty 
character string is permitted.  

 
The export is executed using the button ‘finish'. 
 
 
 

2.5.3.1 setup channels 
 
The dialog allows the selection of several channels from any device managed by SmartGraph.  
 
The available devices are displayed in a list on the left hand side of the dialog. The device can be 
selected by clicking on the corresponding entry. The selected entry then appears highlighted.  
 
All available channels of the selected device are displayed in the list next to the device list. Channels 
that have been selected are moved to the list on the right side. 
 
Channels can be selected (moved to the list on the right) with the buttons  (if a single channel is 
selected) and  (if more then one channel is selected). To select multiple channels use the left 
mouse button together with the 'Shift' and 'Control' keys. To select all channels use the button 'Select 
All'.  
 
The sequence of the selected channels can be changed with the buttons  and . The selected 
channel will be moved up/down in the list. The channels will appear in the export file in the order 
specified here.  
 
A channel can be removed from the list of selected channels with the button . 
 
With 'OK' the selected channels are passed back to the export dialog. 
 
With ‘cancel’ the dialog is ended without transferring the selection.  
 

2.5.3 Language 
Change the current language. This function can be selected by clicking the corresponding button on 
the tool bar. 
 

2.5.4 Upgrade 
Order/unlock key code for professional version. 
 
See also: 1.7 Upgrade to Extended Functions 
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2.6 Help Menu 
 

2.6.1 Additions to the manual 
Show recent changes and additions to the manual that have been implemented after the manual has 
been printed. 
 

2.6.2 Contents 
Start the online help and show the contents index of the help topics. 
 

2.6.3 Using Help 
Show introduction to the Windows Help system. 

2.6.4 Info 
Show version number and copyright information for SmartGraph. 
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3 Appendix 
 

3.1 Keyboard Shortcuts 
 
For all scroll and zoom functions keyboard shortcuts are available. Depending on the selected 
device/object, the following key shortcuts are defined:  
 
diagrams and tables : 

- Ctrl+ Object Full Screen  
- Ctrl- Reverse Object Full Screen  
- TAB Change to Next Object 

 
diagrams: 

- + zoom in  
- - zoom out 
- -> Scroll Right 
- <- Scroll Left 
- Ctrl -> Page Right 
- Ctrl <- Page Left 
- End Data End 

 
tables: 

- Cursor Up Scroll Up 
- Cursor Down Scroll Down 
- Page Up Large Step Back 
- Page Down Large Step Forwards 
- Ctrl + Cursor Up Scroll Back by 1 Day/Month/Year 
- Ctrl + Cursor Down Scroll Forward by 1 Day/Month/Year 
- <- Scroll Left 
- -> Scroll Right 
- Ctrl -> Large Step to Right 
- Ctrl <- Large Step to Left 
- Pos1 Go To Beginning of Table 
- End Go To End of Table 
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